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A computer can be defined as an electronic machine or device that accepts data and 

instructions as input, performs processing (calculations and other operations) on the 

data according to the given instructions and produces the results as output. 

Computers can also store data for later uses in appropriate storage devices and 

retrieve whenever it is necessary. 

Charles Babbage designed the difference engine in 1820s and thus is also known as 

Father of Computer 

 

Generation of Computer 

Types of computers are classified into generations depending on their basic 

characteristics.  

A computer belonging to a particular generation shares similar properties with the 

other computers of that group.  

 

First generation computers (1949 to 1955) 

 These were very early stage computers that were designed for mathematical 

and scientific users. 

 Vacuum tubes were the main components in first generation computers. 

 The size of these computers was huge and they weighted in tones. 

 Machine language was used to provide instructions to these computers and 

the programming was very difficult. 



 They had slow operating speed, consumed a lot of electricity and had small 

memory. 

Examples: ENIAC (Electronic Numerical Integrator and Calculator) 

UNIVAC (Universal Automatic Computer) 

 

Second generation computers (1956 to 1965) 

 The commercial production of computers started. 

 Second generation computers used transistors in place of vacuum tubes. 

 A transistor is very small as compared to vacuum tube and they consume very 

less electricity and produce less heat. 

 The concept of storage space came and “Magnetic core memories” were 

developed. 

 Operating system and computer programming languages were developed. 

Examples: IBM 1401, CDC 3600 

 

Third generation computers (1966 to 1975) 

 A new device known as “Integrated circuit” or “Chip” was invented. 

 The integrated circuits replaced the transistors in computers. 

 Integrated circuit was created by grouping many transistors and other 

components on a very small silicon chip. 

 These computers were smaller in size, more efficient and faster in working 

and contain huge memories than earlier generation computers. 

 They supported high level programming languages. 

 These computers were cheaper and now available in offices. 

Examples: ICL 1900, Honeywell model 

 

Fourth generation computers (1976 to Present) 

 Microprocessors were developed in this generation 

 VLSI technology (Very Large Scale Integrated) Circuits were used in 

computers. 

 Thousands of small components were packed on a single chip 



 Microprocessor is also called as CPU (Central Processing Unit). 

 Magnetic semiconductor memories are mainly used in these computers 

 They contain huge storage volumes in the form of magnetic and optical 

storage. 

Examples: STAR 1000, DEC 10 

 

Fifth generation computers (Upcoming) 

 “Artificial Intelligence” is the focus area of this generation 

 Fifth generation computers would be able to learn from the environment and 

take decisions. 

 These computers will have learning and decision making powers 

 These computers will be based on parallel processing using multiple CPUs 

and will have permanent storage devices. 

 

Block Diagram of a Computer 

Any computer system has essentially four important parts normally input unit, 

central processing unit, storage unit and output unit. 

Computers perform following five basic operations for converting raw input data 

into information useful to users. 

1. Inputting: The process of entering data and instructions into computer system 

is called inputting. 

 

2. Storing: Saving data and instructions so that they are available for future use 

whenever required. 

 

3. Processing: Performing arithmetic operations (like add, subtract, multiply, 

divide etc.) or logical operations (like less than, greater than etc.) on data in 

order to convert them into useful information  

 

4. Outputting: The process of obtaining useful information or results to user such 

as printed report or visual display. 

 



5. Controlling: Detecting the manner and sequence in which all above operations 

are performed.  

 

In the figure, the solid lines are used to indicate the flow of instruction and data and 

the dotted lines represent the control exercised by the control unit. 

 

Hardware 

The physical components of a computer are collectively known as computer 

hardware. 

All the physical parts of a computer that can be touched or seen is called hardware. 

Examples: CPU, Keyboards, mouse, printer etc. 

 

Computer Hardware can be categorized into two parts 

a. Internal hardware components 

b. External hardware components 



 

A. Internal hardware components: These are necessary for the appropriate 

functioning of the computer. It includes motherboard, CPU, RAM, ROM, 

Hard disk drive, Solid state drive, Graphic processing unit etc. 

 

B. External hardware components: These are externally attached to the 

computer to add or improve its functionality. It includes mouse, keyboard, 

touchpad, camera, printer, scanner etc. 

 

Software 

A set of computer programs that is designed to perform well-defined functions. A 

program is a sequence/ set of instructions which are written to solve a problem. 

It is different from hardware but both hardware and software work collectively to 

perform a task. 

Software includes instructions that tell computer hardware what and how to do, data 

and other set of documents that are helpful to the programmer, user and operators. 

Software can be categorized into two types: 

a. System software 

b. Application software 

 

A. System software: System software is a collection of programs designed to 

operate, control and extend the processing capabilities of the computer itself. 

System software acts as the intermediary between the hardware and the end 

users. 

Example: Operating system, assemblers, interpreter etc. 

 

B. Application software: It is designed to cater a particular need of a particular 

environment. It directs computer to execute the commands and given by user. 

Example: word processor, spreadsheets, any web application etc. 

 

Booting 



Booting is the process of starting a computer.  

Booting can be performed either by hardware action, such as pressing a button or by 

a software command. When you put the computer on, it needs to bring the hardware 

in a condition in which it can understand and act as per user requirement. For this it 

needs loading of operating system into the computer main memory. 

This process of starting the computer and loading the operating system like 

Windows, Linux etc. into its main memory is called Booting. 

 

There are two types of Booting 

a. Cold booting 

b. Hot booting 

 

A. Cold booting: In cold booting, the computer is started or powered ON from 

shut-down state. During cold-booting, all the instructions are read by the 

system from the ROM (BIOS) and the operating system will be automatically 

loaded into the system. 

This booting is also called as Hard booting 

This booting is more time consuming than Hot booting 

 

B. Hot booting: The hot boot is the process of restarting the computer without 

switching off the power supply. In this boot, the computer does not start from 

the initial state. 

This boot is required in cases when system is struck off somewhere (hang 

state) and most commonly Ctrl+Alt+Del buttons are used to reboot the 

system. 

This is also called as warm boot or soft boot.  

 

Steps of Boot process: There are 6 steps 

a. The startup: The switching of power of computer ON is called startup. This 

step supplies electricity to BIOS program in ROM and to the processor of 

computer 



 

b. POST: POST means Power On Self Test. This program is stored on ROM 

and as soon as the power is switched on, the program starts initial check of 

input and output devices connected to computer, RAM and presence of disk 

drivers. If any necessary hardware is found missing, a beep sound is produced 

to report the error and system hangs over there. 

 

c. Loading of operating system: Once POST is performed properly and no 

error occurs then the bootstrap loader program starts loading the operating 

system into the main memory. When the entire operating system gets loaded 

into RAM, the initial files are executed and it is ready to work. 

 

d. System configuration: Now in this step, different drivers are loaded into the 

main memory. Drivers are the special system programs which are necessary 

for functioning of various peripheral devices connected to computer. This is 

called configuring the system 

 

e. Loading system utilities: The basic functioning programs like antivirus 

program, data compression program etc. are called system utilities. After 

configuring the system, these system utilities are loaded in main memory. 

 

f. User authentication: The last step of boot process is user authentication. This 

step is performed if any password has been setup on the computer system. In 

this step, the system allows to enter password and authenticates the user if 

correct password is entered. Once the authentication is done the system is fully 

ready to work on. 

 

Central Processing Unit (Functional Parts and Functions) 

CPU is responsible for actual processing of inputs to generate the output. CPU is 

considered as the brain of computer and is also called as Microprocessor. 

The speed and efficiency of computer mainly depends upon the CPU. 



 

CPU is divided into Arithmetic Logic Unit (ALU) and Control Unit (CU) 

ALU performs Arithmetic and Logical calculations 

CU supervises the working of ALU 

 

a. Control Unit: CU supervises the working of ALU. CU decides the sequence 

of programs to be executed. It also coordinates the functioning of various 

input output devices attached to computer. 

 

b. Arithmetic Logic Unit: ALU is part of CPU where actual calculations and 

logical comparisons are performed. The arithmetic calculations involve 

addition, subtraction, greater than, less than etc. 

These calculations are performed on data that is stored in internal storage areas 

of CPU, called registers. 

 

c. Registers: Registers are internal storage locations inside the CPU that are 

used to store instructions or data. These registers are used by ALU and CU for 

storing intermediate results and control information. 

Types of Registers are 

 The Program Counter is used to keep the address of the next 

instruction to be fetched. 



 The Instruction Register is used to store the address of the current 

instruction that is being processed  

 The Address Registers are used by instructions for indirectly accessing 

the contents of memory by its address. 

 

Memory 

Memory is responsible for storing the data and instructions either temporarily or 

permanently. 

Memory is the storage area where all the inputs are stored before processing and the 

outputs are stored after processing of inputs. 

Memory also serves as the space to store the instructions. 

 

Functions of memory 

Stores the data and instructions to be processed 

Stores intermediate result for processing 

Stores the final results of processing before these are released to an output device. 

 

Primary and Secondary Memory 

Primary memory: Primary memory is the main memory that the CPU has access 

to. This is also known as volatile memory. The storage capacity of these memories 

is far less than secondary storage devices. Primary memory is used when you start 

the computer and when using some application file that has not been saved in the 

secondary storage. 

RAM and cache memory are examples of it. 

RAM (Random Access Memory) is a type of primary memory. It is used by all the 

programs running on the computer. It is a read write memory which means you can 

read the information stored in this memory as well as write new information into this 

memory.  



ROM (Read-only memory) is the other type of primary memory. ROM is used to 

store instructions that are important for starting up a computer. ROM contains 

several programs that run automatically when you start a computer. 

ROM is a permanent memory and its contents are retained when you switch off the 

computer. 

Modern computers contain utility programs to edit and store the data stored in ROM 

chips. 

Some types of ROM are 

a. PROM (Programmable Read Only Memory) 

b. EPROM (Erasable Programmable Read Only Memory) 

c. EEPROM (Electrically Erasable Programmable Read Only Memory) 

 

 

Secondary Memory:  

The secondary memory devices are used to permanently store the information 

generated from computer. Secondary memory is a non-volatile memory that is 

external to the computer. It is the type of memory that is available to the user in the 

form of various devices and media.  

Examples: Hard disk, CDs, DVDs, USB storage devices 

Advantages of secondary memory:  

a. Permanent storage where data is not lost when we switch off the computer. 

b. Huge storage capacity (Several GBs or TBs) 

c. Low storage cost of data 



d. Data transfer between two or more storage computers 

 

Volatile and Non-volatile memory 

Volatile memory is a type of computer memory that requires power to maintain its 

data. When the power supply is turned off, the data stored in volatile memory is lost. 

It is typically used for temporary storage of data that needs to be accessed quickly. 

It is fast but it has limited capacity and is more expensive than non-volatile memory 

Example of volatile memory includes the cache, RAM of the computer  

 

Non-volatile memory 

It can retain the data even when the power supply is turned off. Non-volatile memory 

is used for long-term storage of data that needs to be accessed even after the 

computer has been turned off. 

It is slower than volatile memory but has a much larger capacity and is less 

expensive. 

Example of Non-volatile memory includes optical storage discs, secondary storage 

like ROM, flash memory, hard drives or solid-state drives. 

 

Units of Memory 

a. 1 bit: A bit is a value of either a 0 or 1. It is the space required to store one 

binary digit (0 or 1) in the memory. 

 

b. 1 Nibble: 1 nibble is equal to 4 bit 

 

c. 1 Byte: It consists of 8 bits. It is the space required to store 1 character of 

keyboard (like letter “A” or “B”) 

 

d. 1 KiloByte (KB): The space required to store 1024 Bytes in the memory.           

1 KB = 1024 Bytes 

 



e. 1 MegaByte (MB): The space required to store 1024 KiloBytes in the 

memory.           1 MB = 1024 KB 

 

f. 1 GigaByte (GB): The space required to store 1024 MegaBytes in the 

memory.           1 GB = 1024 MB 

 

g. 1 TerraByte (TB): The space required to store 1024 GigaBytes in the memory.           

1 TB = 1024 GB 

 

h. 1 PetaByte (PB): The space required to store 1024 TerraBytes in the memory.           

1 PB = 1024 TB 

 

Some abbreviations: 

 CPU: Central Processing Unit 

 RAM: Random Access Memory 

 ROM: Read-only Memory 

 BIOS: Basic Input/Output System 

 GPU: Graphics Processing Unit 

 ALU: Arithmetic Logic Unit 

 USB: Universal Serial Bus 

 HDD: Hard Disk Drive 

 SSD: Solid State Drive 

 

Storage Devices 

Computer storage devices are used to store huge amounts of data and information 

permanently. 

Different types of storage devices are  

1. Magnetic storage devices: They use magnetized material to save the data. 

When the device gets connected to a computer, a powerful magnetic field is 



formed and the machine can read and store binary information using the two 

magnetic polarities. 

Examples: Hard drive, Floppy disk, Zip-disk etc. 

 

2. Optical storage devices: Lasers and lights are utilized to detect and store 

information in these devices. They are cheaper than USB drives and can store 

more data. 

Example: CD-ROM, DVD, Blu-ray disc etc. 

 

 



3. Flash Memory Devices: These devices display both magnetic disks and 

storage technologies. They are simple to use, transportable and readily 

available. They are more cost effective and convenient method of data storage. 

Examples: USB drive (pen drive), memory card 

 

 

Cache Memory: Cache memory is a very high speed memory which is placed 

between the processor and main memory to adjust the difference of their working 

speed. Its objective is maximizing CPU utilization.  

The frequently accessed data and instructions are stored in cache memory so that 

they are immediately available to the CPU when needed.  

Cache memory is used to reduce the average time to access data from the main 

memory. 

 



Various types of cache memory are 

Level 1 or L1 cache (Present inside the CPU) 

L2 cache (It is present on board, maybe inside or outside the CPU) 

L3 cache (Located outside the CPU but in close proximity) 

 

CPU speed and CPU word length 

CPU performance is dependent on two main factors 

a. Clock speed 

b. Word length 

 

CPU clock speed or clock rate tells how fast a CPU can work. 

Or how many instructions cycles the CPU can deal with in a second. 

It is measured in Hertz. 

The faster the clock speed, the faster would be the processing of data by the 

computer. 

 

Word length corresponds to maximum number of bits of information that a 

computer can process at one time. 

It is expressed in terms of bits. 

The larger the word length is, the faster the computer. 

 

 

Basic Internet Skills 

 

Data communication means sending data electronically from one computer to 

another. It involves linking of computers, which allows the resources of one 

computer to be shared by the other. 



Computer network is a group of computers and peripheral devices connected 

through a data communication system. A computer network facilitates the sharing 

of hardware and software resources among different users working on different 

computers. 

The aim of networking is to share resources. 

Hardware sharing: All the devices like printer, scanner etc. are attached to a remote 

server which is shared among multiple computers. 

Software sharing: Every application software can be installed on main server rather 

than installing it on every computer individually. 

Efficiency of hardware and software resources: As all the resources are installed 

at a single point so all the modifications can be done at that single point. 

Reduces Data redundancy: The data that is used by multiple people can be stored 

at single point and shared through common network. This reduces data redundancy. 

Saves Paper and time: Files can be shared digitally. 

Internet sharing: Common network gives access to internet to all the systems.  

Security: As all the data is there on the server so securing that server is enough to 

secure the data. 

 

Browser 

Web browser is a software that interprets the markup of files in HTML, formats them 

into web pages and displays them to the user. 

It is a software program on your computer which is used to access information from 

World Wide Web servers. 

The largest networked collection of linked documents is known as World Wide Web. 

In web browser 

1. A window displaying the current page 

2. Web links which changes colors when used (Initially they are in blue color 

and after using they turn purple) 



3. A row of button at the top of browser window which are home button, back 

and forward buttons, stop button. There are also The Go menu and Preferences 

and the Bookmarks. 

 

URL (Uniform Resource Locator) 

Each web page or internet can be accessed by using a unique address, this unique 

address is called URL. 

Web browser uses a URL to identify the location of a web page. 

Example: http://www.kuk.edu/lib/btech.html 

 

Structure of URL 

URL contains three parts.  

First part http specifies the protocol. HTTP will be used to transfer the content of 

web page. 

Second part www.kuk.edu specifies the address of site. (In this, edu specifies that 

this is education site, www specifies that this site is on world wide web, kuk is name 

of the organization which hosted the website) 

Third part /lib/btech html specifies the path of file btech.html which is stored in the 

folder lib. 



 

 

World Wide Web (WWW) 

WWW is a network of millions of servers, hosts and users. The contents stored on 

web are accessed through web browsers. 

WWW is also a tool to find and retrieve information using links to other web pages. 

 

Hypertext: Hypertext is similar to normal text but it is linked to another text or page 

or information content. 

Hypermedia is advanced version of hypertext document as it contains sound, image 

or video apart from text. 

 

Three key components of www are 



a. URL (Uniform Resource Locator) 

b. HTTP (Hyper Text Transfer Protocol) 

c. HTML (Hyper Text Markup Language) 

 

HTTP defines how information is transferred between the server and the browser. 

All HTML files are transferred using HTTP protocol. The HTTP protocol is a 

TCP/IP (Transmission Control Protocol / Internet Protocol) based protocol. 

HTML is used for creating web pages. WWW is a collection of millions of online 

documents which are written in HTML and they provide a link from one document 

to other. HTML is based on a set of predefined tags. Using these tags, we can alter 

the text like underline it, bold or italic it etc. 

 

Efficient use of search engines 

A search engine is a collection of program that gathers information from the web, 

indexes it and puts it in a database so that it can be searched. Search engine uses just 

keywords or phrases to search the result. 

Search engine contains a computer program called ‘spider’ or ‘crawler’ or ‘bot’ or 

‘robot’ which is responsible for building up the database attached with each search 

engine. 

Various search engines are: 

 



 

Starting a search engine 

Step 1: Enter the URL of a search engine like www.google.com and then press enter 

key. 

Step 2: Type what you want to search in the search box 

Step 3: Clicking the search button, a large number of hyperlinks are retrieved in 

accordance to their relevance to the search topic.  

 

Figure 1 Shows the Step 1 

 

Figure 2 Shows the Step 2 

http://www.google.com/


 

Figure 3 Shows the Step 3 

 

About GOOGLE search engine 

 Google is a user friendly search engine. 

 It is not case sensitive 

 It does not use wild card characters 

 It supports logical operations ‘OR’ 

 It can restrict the search to specific extensions 

 Implied operators +, -, & are used to indicate the existence of a word or its 

absence.  

 

Digital India 

This program was launched by Prime Minister of India, Sh. Narendra Modi on July 

1, 2015. 

The program ensures that govt. services are made available to citizens in electronic 

forms. It is done by improving online infrastructure and increasing internet 

connectivity. 

The important initiatives under Digital India campaign are 

 Digilocker 

 E-education 

 E-health 

 E-kranti 



 E-hospitals 

 BHIM-UPI portal 

 

Digital India portal has been launched by Government of India to comprise all the 

services on a single portal. It started in 2017. Department of Electronics and 

Information Technology (DIETY) is running this project with state and central 

government. 

Objectives of Digital India portal are 

 Provides e-payment system 

 Provides delivery services 

 Provices PAN, AADHAAR related services 

 Bill payment, shopping, certificates, passport, driving licence etc. 

 

National portal of India provides a single window access to information and 

services that are electronically delivered from all the government departments. It 

presents information resources and online services from government sources 

accessible from a single point. 

Example: NSP (National Scholarship Portal) 

 

State portals are developed for each state separately to provide access to 

information and services available for separate state. 

Example: Haryana state has CM Window, E-mausam Krishi service etc. 

 

E-mail (Electronic Mail) 

Electronic mail is popularly known as E-mail and its purpose is to send the 

electronic formatted message.  

Email provides the ability to distribute information to large number of people 

virtually, instantaneously and inexpensively. 



 

 

Log-in 

 



 

E-mail service providers in India 

Top free providers include Gmail, Yahoo, Outlook, AOL, Zoho, Mail.Com, and 

ProtonMail. Some other Email providers are CounterMail, Hushmail, and 

Tutanota.  

 

Effective use of Gmail 

1. Use labels to categorize the emails 

2. Install Gmail add-ons like Docu sign, Grammarly, Gphy etc. 

3. Use Gmail shortcuts for various steps 

4. Keyboard based search operators to work faster 

  

 

5. Clean Gmail inbox regularly to use it effectively. Can also use Autoclean 

feature of Gmail. 

6. Unsubscribe email on Gmail which you no longer need. 

 

Effective use of Google Drive 

Google drive or G drive allows to store documents, images, videos etc. remotely to 

the cloud and they can be accessed from anywhere. 

Initial drive storage of 15 GB is free and can be accessed from any device. 



 

 

1. Find the needed file using search after opening google drive 

2. Publish the file to web for making the sharing of file publically in simple 

ways. 

3. Pull out text from images while saving them 

4. Shorten long links using URL shortener add-on 

5. Back-up and sync the files from laptop or phone 

6. Use color code in the files to find them fast 

7. Use keyboard shortcuts to save time and clicks. 

 

Google Calendar 

Google calendar is a time management and scheduling service. 

It allows user to edit and create events and comes free with google account.  

It can be used on laptop and mobile phones 

On this, we can quickly schedule meetings and events and can get reminders about 

them 

We can share our schedule with others also and they can make changes as well 



It has a set start time and stop time option along with option for all day event. 

Recurring functions can also be used for frequency. 

Colors can be used to highlight the events. 

Locations can be added, notifications can be sent and events can be seen on other 

phones also. 

 



 

 

Googles Sites 

Google sites is a free website builder from google. It allows to create website with 

ease just by dragging the content we need. 

It also allows us to create website with another user as it can give edit access to 

others. It happens in real time. 

It is compatible with other google services like google sheets, google slides, google 

docs etc. 

The site is completely free and there is no limit on number of sites that we can 

create within 15GB of storage. 

No background in coding and web development is required as it is very user 

friendly and have templates. 

It is a good option for a free service, work presentations, small businesses etc. as 

we can add links, images, videos, text and much more 



 

 

 

Sign in to google account and go to google sites homepage. 

Pick the template to use under “start new site”. Also there are various options in 

“Template gallery” out of which “Events” is selected here. 



Enter all the required details and contents of the site and once all of this is done, hit 

Publish 

In the pop-up box after hitting Publish, choose the URL you want and can also 

customize it. 

Once finished, click on Publish again to make the website visible to others. 

 

Google Sheets 

It is a spreadsheet program developed by Google. 

It organizes the data into rows and columns and allows you to do mathematical and 

logical operations on them 

It can be used in daily life as well as work life. 

Use of google sheets does not require programming knowledge and does not 

require downloading or installing of program on computer. 

It runs on the web browser. 

 



 

 

Google sheets allows format and styles for the spreadsheet. 

It allows change of colors, font type, font size, borders, numbers etc. 

It allows real time collaborative editing. 

It is free to use, require minimal training, customizable and it is collaborative than 

other similar tools 

 

Online Communication and Conferencing 

Online communication means sharing of information or communication over a 

computer network or telecommunication network. A phone call or online chats are 

different ways of online communication. 

 

Online Conferencing is a service which allows an audio or video conferencing or 

meeting through web services. Participants can see, talk and hear to each other in 

real time. 

 

A Webcast is a video broadcast of an event transmitted over the internet. 



A Webinar is an event held virtually which is attended exclusively by an online 

audience. Audience can hear and see the presenters but attendees are not seen or 

heard in the webinar. 

 

A web meeting as an audio, web video conferencing solution that combines all 

services into one online web meeting service. In this, people from different parts of 

world can see, talk, message each other in real time. 

 

A Web conferencing software allows the participants to conduct or attend the web 

meeting. It enables remote meeting based on VoIP (Voice over Internet Protocol) 

(Voice call using internet), online video, audio, instant messages, file sharing, 

screen sharing. 

Some examples are Skype, Google meet, Zoom, Cisco webex, Click meeting etc.  

 

Google Meet 

Google meet is a video conferencing platform where google allows real-time 

meetings using the browser, sharing video, desktop, files, screen, presentation with 

others. 

It is not necessary to install in on desktop or phone and can be accessed through 

browser.  

It can be used for audio and video calls where team members can be invited, they 

can join by a meeting code or by clicking on the meeting link. 



 

 

WebEx  

It is a multifunctional desktop audio/video conference call solution provided by 

Cisco. 

It allows to meet anyone throughout the globe using web services and meetings 

happen in real time. 

It is required to install it on desktop or mobile phone 

It is suitable for both small and large group meetings and for audio and video calls 

 

 

Basic Logic Building 

 

Logic building is essential for computer programming. It involves breaking down 

the problem into smaller, manageable parts and defining the steps required to solve 

it. 



A program is a sequence of instructions that is written in a computer programming 

language. Programming is needed to develop various types of software. 

A programming language is a formal language comprising a set of instructions that 

produce various types of outputs. 

 

Steps in Problem solving 

Following are the mainly used steps while creating a program 

1. Problem analysis: In this phase, the internal logic of the program is planned. 

Various program analysis techniques are used to represent the logic of the 

program and flow charts, pseudo codes, algorithms and decision tables are 

mainly used tools for this purpose. Program analyst performs the analysis 

phase and he chooses the most efficient way. 

 

2. Coding: After the development of desired logic and sequence of steps, next 

comes the coding stage. In this stage, a programming language like C and C++ 

is selected and the program instructions are coded as per syntax of the chosen 

language. Other languages in use are Java, visual C++ etc. 

 

3. Debugging: After the coding is done, the program is checked for all kinds of 

syntax and grammatical mistakes. This includes removing of errors due to 

invalid syntaxes like absence of semicolon (;) or logical error like absence of 

increment/ decrement step in a while loop.  

The process of removing all kinds of error in the program is called debugging. 

 

4. Testing: After removing all the errors from the program, it is executed and 

supplied with valid input to see whether the program returns the accurate 

output. 

 

Algorithm:  

Algorithm is a sequence of instructions to solve a particular problem. Algorithm is 

independent of any programming language and can be written in simple English 

language as it is a representation of instruction sequence of the solution. 

A problem may have multiple algorithms for its solution. 



The instructions written in an algorithm must have following characteristics: 

a. Each instruction must be precise and unambiguous. 

b. Each instruction should be written in such a manner that it can be performed 

in a finite time 

c. One or more instructions should not be repeated infinitely. The program 

should stop after a given number of iterations. 

d. After executing the steps of algorithm, desired result must be obtained. 

e. The variable names of algorithm must represent the entity they represent in 

the program. Example, a variable to represent basic salary should be named 

basic_sal or b_sal etc. 

 

Example 1: Consider a box where no one can see what is happening inside, it is 

covered on all sides. We give input to the box and it gives output we need but the 

procedure behind this conversion of input to output is an Algorithm. 

 

Example 2: Write an algorithm to find the average of three subjects. 

Step 1: Start 

Step 2: Declare and read 3 subjects, let’s say S1, S2, S3 

Step 3: Calculate the sum of all the 3 subject values and store result in sum variable 

(Sum = S1+S2+S3) 

Step 4: Divide sum by 3 and assign it to Average variable (Average = Sum/3) 

Step 5: Print the value of Average of 3 subjects 

Step 6: Stop 

 

Example 3: Write an algorithm to count number of males out of 1000 people of a 

town. 

Step 1: Start 

Step 2: Initialize GENDER, COUNT and MALE to zero 

Step 3: Input gender of the person 



Step 4: If gender = male, Increment male and count by 1 

   If gender =/= male, Increment count by 1 

Step 5: Check count to see if it is less than 1000 

Step 6: If count < 1000, repeat from step 3 

Step 7: Repeat till Count = 1000 

Step 8: Print MALE 

Step 9: Stop 

 

Steps for Algorithm development 

It is a series of specific steps which solve a particular problem and which the 

programmer can translate into a computer program in some programming language. 

There are five major steps: 

Step 1: Obtain a description of problem 

The problem description must be stated clearly, it must be unambiguous, it must be 

complete without internal contradictions 

 

Step 2: Analyze the Problem 

This step is to determine the starting and end point for solving the problem. At the 

starting point, we look at the data available and at the end point, we look at the new 

facts that we have. 

 

Step 3: Develop a high-level algorithm 

High-level algorithm means having high level of detailing in the planning. Each step 

is detailed out to further level of detailing. It shows the major steps that need to be 

followed to solve a problem. 

 

Step 4: Refine the algorithm by adding more details 



More details are added to the steps and the level of detailing depends upon the 

situation. Each time more detail is added to the previous algorithm. 

 

Step 5: Review the algorithm 

The algorithm needs to be analyzed step by step to determine whether or not it will 

solve original problem 

 

Flowchart: 

A flowchart is a graphical method of representing the logical flow of the program. 

It uses different shapes to denote different types of instructions and actual 

instructions are written within these shapes. 

Different shapes or boxes of a flowchart are connected by solid lines which indicate 

the flow of program. Program flow is the exact sequence in which the instructions 

are to be executed. 

While generating solution for a problem, an algorithm is created first and then it is 

represented through flow chart. 

It is easier to trap any kind of logical error in a flow chart as compared to an 

algorithm. 

 

Flowchart Symbols: A flowchart uses different symbols to represent different 

functions in the program. 



 



 

 

Limitations of flow charts: 

1. Flowcharts are very time consuming. 

2. They are difficult to draw with proper symbols and spacing. 

3. A little modification in the logic of program needs redrawing the whole flowchart 

again. 

4. There are no set standards for explaining the depth of detail that should be 

included in a flowchart. 

 

 

 

 

 



Example: 

 

 



Differences between Algorithm and Flowchart 

1. Algorithms can be written in a simple language whereas flowcharts are visual 

diagrams. 

2. An algorithm is a set of instructions whereas a flowchart is a graphical 

representation of those instructions. 

3. Algorithms are more precise and can be used to solve any problem whereas 

flowcharts are more general and are used to understand algorithms. 

4. Algorithms focus on the sequence of steps to solve a problem whereas 

flowcharts focus on the flow of data. 

5. Algorithms are easier to modify whereas flowcharts can be difficult to modify  

6. Algorithm came from Persian mathematician Al Khwarizmi whereas 

Flowchart was introduced by Frank Gilberth. 

 

 

Office Tools 

 

Very Short Answer Questions: (02 Marks) 

1. Define office tool. 

Answer: Office tools are application software that help the user to perform office 

related tasks easily and efficiently. These tools help user to create, edit, manage and 

manipulate large amount of documents and data. Example: Libre Office, MS Office 

 

2. Name any two freely available office tools. 

Answer: Open Office and LibreOffice are two freely available office tools. 

 

3. What is Calc? 

Answer: Calc is a spreadsheet application of LibreOffice. It contains all the 

advanced analysis, charting and decision making features expected from a 

spreadsheet. 



 

4. What do you mean by auto formatting? 

Answer: Auto formatting in OpenOffice refers to the automatic application of 

formatting styles and settings to text and documents based on predefined rules. It 

can save time and help maintain consistency in the documents. Can auto format 

paragraph style and character style. 

 

5. Define hyperlink. 

Answer: A hyperlink is a link or web link. It is an icon, graphic or text that links 

to another file or object. When you click on a link, it takes you to the target of 

the link which maybe a webpage, document or other online content then it is 

called hyperlink. 

 

6. What are book marks? 

Answer: A bookmark is an object which is used to record a location in a word 

document. Bookmarks are listed in the navigator and you can insert a bookmark 

at the cursor position. Go to “Insert” then “Bookmark”. 

 

7. What do you mean by grouping of cells? 

Answer: Grouping of cells in a spreadsheet refers to the action of combining 

multiple adjacent cells into a single, larger cell. This grouping helps organize and 

manage data in a good manner. 

 

8. Write steps to insert new sheet in the workbook. 

Answer: The steps are as follows 

a. Open the Calc workbook. 

b. Click on the sheet that is adjacent to where you want to insert the new sheet. 

c. Right-click on the selected sheet tab. 

d. Choose "Insert Sheet": 

 

9. Write method to rename a sheet in workbook. 



Answer:  

a. Open the Excel workbook. 

b. Click on the sheet tab at the bottom of the Excel window to select the sheet 

you want to rename. 

c. Right-click on the selected sheet tab. 

d. Choose "Rename" 

e. Type New Name 

f. Press Enter 

 

10. What are nested functions? 

Answer: Nested functions refer to the practice of using one function as an 

argument within another function in spreadsheet context.  

In simpler terms, you incorporate one function's output as input for another 

function. 

 

11. What is the role of navigator? 

Answer: The navigator allows you to see all the components of the document 

such as headings, tables, objects, pictures, text marks etc. The navigator is located 

on standard toolbar. 

 

 

Short Answer Questions: (04 Marks) 

1. What tools are generally present in an Office tool suite? 

Answer: Some of the MS Office tools are 

a. Microsoft Word: It is a word processor that helps user to create, edit, 

manipulate text documents such as letters, reports, resume etc. 

 

b. Microsoft Excel: It is an electronic spreadsheet program that helps users to 

create workbook, store, organize and manipulate data in simple and complex 

spreadsheets. 



 

c. Microsoft PowerPoint: It helps to create presentations and visually display 

information in form of simple slide show to professional multimedia 

presentations. 

 

d. MS OneNote: It is digital alternative of paper notebook provided by MS 

Office. It helps user to create, organize and spare note easily. 

 

e. MS Access: It is a database management system. It helps to link and use data 

from other sources, create and manipulate databases and create simple 

business applications. 

 

f. MS Outlook: It helps user to manage personal information, emails etc. It can 

also be used to store contact information, calenders, organize meetings, 

manage tasks etc. 

 

g. MS Publisher: It is a graphic design application that gives users creating 

material for publications and marketing in form of layouts and design of 

documents. 

 

 

2. Name various components of Open Office tool. Also define the open 

office. 

Answer: OpenOffice, is a free and open-source office suite that provides a set 

of productivity tools for word processing, spreadsheet calculations, 

presentations graphics, databases, and more. 

Various components of Open Office tool are 

a. Writer: A word processing application similar to Microsoft Word. It is used 

for creating and formatting text documents, reports, and letters. 

 

b. Calc: A spreadsheet application comparable to Microsoft Excel. Calc is used 

for performing calculations, creating charts, and analyzing numerical data. 

 



c. Impress: A presentation application similar to Microsoft PowerPoint. 

Impress is used for creating slideshows, presentations, and multimedia-rich 

content. 

 

d. Draw: A vector graphics editor that allows users to create diagrams, 

flowcharts, and other illustrations. 

 

e. Base: A database management application similar to Microsoft Access. Base 

is used for creating and managing databases, creating forms, and running 

queries. 

 

f. Navigator: A tool that aids in navigating and managing different elements 

within documents. It provides an overview of the document structure and 

allows users to easily move between sections. 

 

 

3. Write steps to insert image in Writer using drag and drop. 

Answer:  

a. Open the document in which you want to insert the image. 

b. Open the File Explorer (Windows) and locate the image file you want 

to insert into your Writer document. 

c. Resize and arrange the Writer window and the File Explorer so that 

both are visible on your screen. 

d. Select and Drag the Image 

e. Click and hold the left mouse button on the image file you want to 

insert. 

f. While holding the mouse button, drag the image file from the File 

Explorer into the open Writer document. 

g. Drop the image into the Writer document. 

 

4. Write advantages and disadvantages of linking of image file. 

Answer:  

Advantages of Linking Image Files: 

a. Reduced Size of the document  



b. Ease of Update of image file outside the document 

c. Same image can be used in multiple documents without having to add it 

separately in each file 

d. Documents with linked images may load faster because the file size is 

smaller. 

 

Disadvantages of Linking Image Files: 

a. Linked images create a dependency on external files. If the linked image file 

is moved, deleted, or inaccessible, the image may not display correctly in the 

document. 

b. When sharing documents, it's essential to ensure that linked image files are 

included otherwise image would not be there. 

c. Linking makes the document complex 

d. If the linked image file is renamed, moved, or deleted, the image will not be 

displayed, leading to potential issues in document presentation. 

 

5. Write any eight advantages of LibreOffice over other office suits. 

Answer: Some advantages are 

a. Libreoffice is free to use. It has no license fee. 

b. It is an open source software with open source license. 

c. It is easy to learn, use and master. 

d. It runs on multiple operating systems including windows, Mac OS, Linux etc. 

e. It provides extensive language support 

f. The components of LibreOffice are well integrated with one another and can 

be used with one another. 

g. It supports many common formats including HTML, XML, PDF etc. 

h. There is no vendor lock-in in LibreOffice. The files are easily unzipped and 

read by any text editor. 

 

6. Name various menus in Menu bar of LibreOffice main window. 

Answer: Various menus are 

a. File: Options like opening, saving, and printing documents. 



b. Edit: Options cut, copy, paste, and other editing operations. 

c. View: Settings such as zoom levels, toolbars, and the sidebar. 

d. Insert: Options for inserting images, tables, charts, and more. 

e. Format: Options for formatting text, paragraphs, and other document 

elements. 

f. Styles: Managing and applying styles to text, paragraphs, and page elements. 

g. Table: Options related to working with tables 

h. Tools: Various tools for spell checking, grammar checking, language settings, 

and other utilities. 

i. Window: Options for managing multiple open documents and arranging 

document windows. 

j. Help: Access to the LibreOffice Help system and other help-related resources. 

 

7. Name various cell formats allowed by OO Calc. 

Answer: Various formats are 

a. Number: Formats numbers for general display. 

b. Date: Formats cells to display dates.  

c. Time: Formats cells to display time. 

d. Currency: Formats numbers as currency, including a currency symbol. 

e. Percentage: Converts numbers into percentages 

f. Fraction: Displays numbers as fractions. 

g. Scientific: Formats numbers in scientific notation 

h. Text: Treats the cell content as text 

i. Boolean: Formats cells to display "TRUE" or "FALSE" for Boolean values. 

j. Custom: Allows you to create custom formats using a combination of symbols, 

letters, and placeholders. 

 

8. Write the operations of following four functions in Calc – WEEKDAY, 

YEARS, DATEVALUE, ISLEAPYEAR. 

Answer: 

WEEKDAY: Returns the day of week for a given date 

YEAR: Return the year of a given date 



DATEVALUE: Returns a date-time serial number from a text date 

ISLEAPYEAR: Tests if a date is in a leap year 

 

9. What is a formula in CalC? Explain with help of examples. 

Answer: A formula is an expression that performs calculations or operations on 

data within a spreadsheet.  

All formulas in Calc begin with an equal sign (=). 

A cell reference is the address of a cell in the spreadsheet, identified by its 

column letter and row number. For example, A1 refers to the cell in the first 

column and first row. 

Example: =SUM(A1:A5) adds the values in cells A1 through A5. 

 

10. Write four rules and methods for creating functions in Calc. 

Answer: There is need of specific rules and methods for creating functions in 

Calc 

a. Always place a unique formula in each cell 

b. Use array formula on massive data 

c. Use consolidation functions 

d. Use macros to create functions 

e. Try to break formula into parts and combine the parts where needed 

f. Use multi-threading 

 

11. What is OO Impress? Write any four uses of it. 

Answer: Impress is the tool available in open office suite that creates effective 

multimedia presentations that stand out with 2D and 3D clip art, special effects, 

animation. 

Uses: 

a. Creating effective multimedia presentations with 2D and 3D clip art, special 

effects, animation 

b. Preparing presentations with master pages or download templates 



c. Easy to use drawing and diagram tools with animation and effects. 

d. Impress allows users to export presentations in various formats, including 

PDF 

 

 

12.  Write steps to insert new slide in impress document. 

Answer:  

Method 1: 

1. Open the presentation in which you want to insert a new slide. 

2. Click on the slide on the left side of the main window where you want the new 

slide 

3. Go to the “Insert” menu in the top menu bar. 

4. Choose “Slide” from the dropdown menu. 

5. Can choose "Slide Layout" from the dialog box 

6. Click OK to insert the new slide with the chosen layout. 

 

Method 2: 

1. Right-click on the slide on the left side of the main window. 

2. From the context menu, choose New Slide. 

3. Select the desired slide layout. 

4. Click OK. 

 

Long Answer Questions: (08 Marks)  

 

1. What is Open Office Writer? List its important features. 

Answer: It is a word processing application of Open Office tools suit. It helps user 

to create documents like letters, reports, resume, books etc.  

The Writer allows to insert images, graphics, charts etc. from other components to 

its documents. 

It is a powerful tool for creating professional documents. It allows creation, editing 

and viewing any Microsoft word document in both doc and docx format. 



Apart from usual features of word processor, there are some additional features like 

a. Built in drawing tools 

b. Templates and styles 

c. Linking of graphics, spreadsheets and objects 

d. Export to PDF 

e. Database integration 

 

2. Explain character formatting in Writer document. 

Answer: Character formatting involves modifying individual characters or text 

within the document. This includes adjustments to the font, size, color, style, and 

other attributes to enhance the visual presentation. 

Various options for character formatting are:  

a. Style and formatting window 

b. Apply style 

c. Font name 

d. Font size 

e. Bold, Italic, Underline 

f. Superscript, Subscript 

g. Increase font size and decrease font size 

h. Font color 

i. Highlighting 

j. Background color 

k. Character format dialog 

 

3. What is table? Explain insertion and deletion of table in writer document. 

Answer: A table is a grid of rows and columns that intersect to form cells. The lines 

marking the cell boundaries are called grid lines. Open office writer allows to create 

and insert table in documents. 

Inserting a Table: 

Method 1: 

a. Click where you want to insert the table. 



b. Go to Table in the top menu. 

c. Choose Insert and then Table.... 

d. Set the number of rows and columns. 

e. Click OK. 

 

Method 2: Using Table icon 

a. Open the document 

b. Click where you want to insert the table. 

c. Click the arrow to the right side of the “Table” icon 

d. In the drop down grid, select the number of rows and columns for the table 

e. The table will appear at the location of our cursor. 

 

Deleting a Table: 

a. Click inside the table you want to delete. 

b. Go to Table in the top menu. 

c. Choose Delete and then Table. 

d. Click Yes in the confirmation dialog. 

 

4. What is reference range operator in Calc? Explain its use with example. 

Answer: In Calc, the reference range operator is used to specify a range of cells 

in a formula or function. The colon (:) is the reference range operator, and it is 

used to indicate a range of cells between two cell references. 

Start cell : End Cell 

A reference operator selects a range of cells in form of rectangular selection thus 

selecting from upper left corner to lower right corner. 

Example:  

=SUM(A1:A5) 

In this example: 

A1 is the starting cell. 

A5 is the ending cell. 



The formula SUM(A1:A5) instructs Calc to sum the values in the range of cells 

from A1 to A5, inclusively. 

 

5. Explain insertion of Graphic Image/Picture into calc document. 

Answer: There are four ways of inserting images 

a. Using insert picture dialog: Click in the location where you want to insert 

the image in document, then choose “Insert > Picture > From File” or Click 

on the “Insert picture icon” on picture toolbar. 

 

b. Using drag and drop: Open the file browser window and locate the image 

you want to insert. Then drag the image in calc document and drop it where 

you want it to appear. 

c. Inserting from the gallery: Go to “Tools > Gallery”, then click on gallery 

icon. Find the desired picture and right click on it or choose “Insert > 

Copy”. 

 

d. By copy and pasting using clip board: Open the calc document and the 

source document from which image is to be added. In the source document, 

select the image to be copied and press “Control+C”. Now switch to calc 

window and place the cursor where the image is to be inserted then press 

“Control+V” 

 

6. Explain main blank window of OO Impress along with the panes in it. 

Answer: The main blank window of OpenOffice Impress consists of tools and 

features needed to create and edit presentations. 

Various panes in it are 

a. The slides pane: It contains thumbnail pictures of the slides in the 

presentation and they are shown in order. Several operations are possible like 

addition of new slides at any place, marking a slide hidden, deleting a slide, 

renaming a slide, changing the slide transition, changing the sequence of 

slides, changing the slide design, copying or moving the content of one slide 

to another. 

 



b. The tasks pane: It is visible at the right of workspace. It gives access to 

interface controls and it has sections namely Master pages, layout, table 

design, custom animation, slide transition. 

 

c. The master page: It is used to define the page style for the presentation. 

Impress already contains 28 master pages. By default it is blank and rest have 

a background. 

 

d. The layout: in this, 20 layouts are shown out of which you can choose one 

and can also modify it as per requirement. 

 

e. The table design: There are 11 standard table styles provided in table design 

pane and the appearance of the table can be modified. 

 

f. Custom animation: There are variety of animations for one element of a slide 

and animation can be added to a slide. 

 

g. Slide transition: There are 56 slide transitions available in this pane and the 

transition speed can be selected. Time can also be set for automatic transition. 

 

h. The Workspace: It has 5 tabs namely Normal, Outline, Notes, Hand-out and 

Slide sorter. They are called view buttons. The workspace is below the view 

button.  

 

7. Explain the slide show steps in OO Impress. 

Answer:  

a. Open the presentation file you want to present. 

b. Click on the "Slide Show" menu in the menu bar and select "Slide Show" from 

the dropdown. OR Click on the "Slide Show" button on the toolbar. 

c. Some options can be set before starting the slide show like “Slide transition”, 

“Slide transition speed”, “Loop”, “Navigation” 

d. If we want to start from the first slide, click on "From Beginning" in the Slide 

Show menu.  

e. Navigate the slide show using mouse left click or keyboard arrows 



f. To end the slideshow at any point, right-click or press 'Esc.' This will exit the 

Slide Show mode.  

 

8. What is custom slide show? Write steps to set-up a custom slide show. 

Answer: A custom slide show in OpenOffice Impress allows you to create a 

subset of slides from your presentation and present only those selected slides. 

Steps to Set Up a Custom Slide Show: 

a. Open the presentation file you want to create a custom slide show 

b. Click on the "View" menu in the menu bar. 

c. Select "Slide Sorter" from the dropdown menu. 

d. In Slide Sorter view, click on the slides you want to include in your custom 

slide show. 

e. After selecting the slides, go to the "Slide Show" menu in the menu bar. 

f. In the Slide Show menu, hover over "Slide Show Settings" and select 

"Custom Slide Show." 

g. In the Custom Slide Show dialog box, click on the "New" button and enter 

its Name 

h. Click on the "Add" button to add the selected slides to your custom slide 

show. 

i. We can set the order of slides or can also delete any slide. 

j. Click on "OK" button to save your custom slide show 

k. To start your custom slide show, go to the "Slide Show" menu, hover over 

"Slide Show Settings," and select your custom slide show from the list. 

l. Navigation controls are same as mouse left click and keyboard arrow. 

m. To end the custom slide show, right-click or press 'Esc.' 

 

9.  Define slide master and slide design. Write steps to create slide master. 

Answer: 

Slide Master: In OpenOffice Impress, a Slide Master is a template that contains 

the overall layout and formatting for the slides in a presentation. By modifying 

the Slide Master, you can ensure consistent design and formatting across all slides 

in your presentation. Changes made in the Slide Master apply to all slides linked 

to it. 



 

Slide Design: A Slide Design is a collection of design elements, such as 

background styles, color schemes, fonts, and placeholders, that can be applied to 

individual slides or the entire presentation. Slide Designs provide a quick way to 

change the overall look and feel of your slides without directly modifying the 

Slide Master. 

 

A slide master can be created by modifying the default slide master.  

The steps are: 

a. Select “View > Master > Slide Master” 

b. Click the “New Master” icon on the master view toolbar and a second slide 

master will appear in slide pane. 

c. Modify this slide master to suit the requirements and rename it. 

d. When completed, close the master view toolbar to return to normal slide 

editing mode. 

 

10.  What is custom animation? Write steps to add animation effects to your 

presentation. 

Answer: Custom animation OpenOffice Impress, refers to the ability to apply 

specific and personalized animation effects to individual elements on a slide. 

Instead of applying a generic animation to the entire slide, custom animation 

allows you to control how each element appears, moves, or exits during a 

presentation.  

Steps to add animation effect: 

a. Open the presentation file 

b. Click on the "View" menu in the menu bar. 

c. Choose either "Slide Sorter" or "Normal" view 

d. Click on the slide to which you want to add animation effects. 

e. Click on the "Slide Show" menu in the menu bar. 

f. Select "Custom Animation" from the dropdown menu 

g. Click the "Add" button to add an animation effect to an element on the 

selected slide 



h. select the type of animation effect you want to apply and adjust its speed or 

duration etc. 

i. Preview the animation 

j. Can also remove the animation 

k. Once animation is added, close the custom animation pane 

l. Run the slide show to see the animation. 

 


